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Úvod 

Inžinierske dielo slúži ako technická dokumentácia k predmetu Tímový projekt na fakulte 

informatika a informačných technológií Slovenskej technickej univerzity v Bratislave. Opisuje 

štruktúru a postup rozširovania existujúceho projektu na tému Vizualizácia informácií v obo-

hatenej realite. 

V prvej kapitole sa opisujú globálne ciele pre zimný a letný semester, ktoré sa budeme za 

nasledovné mesiace snažiť dosiahnuť. Okrem zakomponovania nových zariadení sme medzi 

ciele zaradili aj údržbu a opravy chýb v projekte. Na projekte robilo súčasne viacero študentov 

a pri spájaní došlo k menším nedostatkom, ktoré spôsobili nefunkčnosť istých funkcií. Na úvod 

sme si zaumienili riešiť tieto nedostatky.  

V druhej kapitole je umiestnený aj celkový pohľad na súčasný systém, z ktorého vychá-

dzame. 

V tretej kapitole sú zverejnené zoznamy modulov implementovaných a plánovaných. 

K modulom prislúcha aj krátky stručný opis. 

V štvrtej kapitole sa nachádzajú opisy modulov, ktoré implementujeme do systému. Po-

drobný priebeh analýzy, návrhu, implementácie a testovania. 

V piatej kapitole je podrobný inštalačný manuál. Základ manuálu bol prebratý z predo-

šlých rokov, avšak postupným aktualizovaním a rozširovaním projektu musel byť manuál tiež 

upravený. Inštalačný návod bol preformátovaný, kvôli prehľadnosti a rozšírené a viacero kro-

kov, ktoré sme spozorovali pri inštalovaní softvéru jednotlivými členmi. Návod je doplnený 

o obrázkové postupy pre ľahšiu orientáciu. 
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1 Globálne ciele 

1.1 Globálne ciele pre zimný semester 

V prvom semestri sa budeme zaoberať analýzou problémovej oblasti. Jednotliví členovia 

sa musia zoznámiť s problematikou vizualizácie informácií. Na predmete tímový projekt sa 

bude vylepšovať a rozširovať existujúci rozsiahli projekt, ktorý má implementovanú funkcio-

nalitu niekoľko hardvérových zariadení. V projekte je pre každé zariadenie vytvorený modul. 

Naším cieľom bude zozname modulov rozšíriť. 

Zimný semester máme na pláne prevažne úpravu zdrojového kódu. Z dôvodu spájaní ba-

kalárskych a diplomových prác došlo k výskytu závažných chýb a nedostatkov. Našou priori-

tou je dostať projekt do stabilného stavu, aby sme mohli neskôr pracovať na implementovaní 

nových modulov do funkčného systému. Pre náš projekt je dôležité pridanie hardvérových za-

riadení na efektívnejšie ovládanie grafov vo virtuálnom svete – 3D myš. Hlavnou výzvou je 

projekcia grafov na okuliare určené pre zobrazenie rozšírenej reality (AR okuliare). 

Po odladení projektu sa začne pracovať na implementácií 3D myšky. Špeciálna myš po-

skytuje používateľovi 6 úrovní voľnosti (pohybom od seba/k sebe simuluje zoom, pohyb do 

strán znamená posuv doľava/doprava, stlačenie alebo vytiahnutie spôsobuje posuv hore/dole 

a otáčanie a naklápanie spôsobuje rotáciu). Ovládanie nahradí potrebu náročnej manipulácie 

s grafmi prostredníctvom klávesnice a klasickej myšky.  

Medzi ďalšie dostupné zariadenia, ktoré máme na pláne implementovať, sú stereosko-

pické okuliare. Použitím okuliarov a vhodného 3D monitora budeme schopní vnímať grafy, 

ktoré boli načítané zo súborov alebo vytvorené analýzou volaných funkcií skriptovacieho ja-

zyka Lua ako trojdimenzionálne objekty. 

Okrem pripájaní nových komponentov máme na pláne rozšíriť aj prezentačnú časť pro-

jektu. Prvotnou výzvou je zobrazenie softvéru klasicky na viacerých monitoroch v režime „ex-

tended“. Následne vyriešiť paralelné spracovanie dát pre individuálne scény a tak vytvoriť „vir-

tuálnu jaskyňu“ (angl. CAVE). 
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Najnáročnejšou úlohou bude správne nasadiť funkcionalitu AR okuliarov. Naša vízia je 

zobrazenie grafu na objekt, ktorý drží používateľ v ruke a je označený špeciálnou značkou. 

Otáčaním objektu sa má otáčať aj samotný graf. Špeciálna značka sa nasníma pomocou modulu 

Aruco, ktorý je už súčasťou projektu a plne funkčný. 

Po úspešnom aplikovaní predošlých modulov sa budeme zaoberať ďalšej problematike 

vizualizácie štruktúry softvéru. Podobne ako pri zobrazovaní grafu volaní, ktorý čerpá dáta zo 

zdrojových kódov jazyka Lua, sa môže vizualizovať aj štruktúra softvéru na základe modulov. 

Cieľom je zobraziť jednotlivé moduly ako grafické objekty, ktoré sú vhodným spôsobom pre-

pojené. Uvedomujúc si, že jednotlivé moduly môžu v sebe zahŕňať ďalšie „podmoduly“, treba 

navrhnúť vnorené objekty, ktoré majú jednoznačne odzrkadľovať štruktúru softvéru. 

Vyriešením predošlej problematiky sa môže vyskúšať prepojenie spomenutých geogra-

fických objektov a grafom volaní, ktorý sa môže vytvoriť z podobných modulov. Výsledkom 

má byť komplexná grafová štruktúra znázorňujúca jednotlivé moduly, graf volaní v moduloch 

a prepojenia medzi modulmi. Komplikované abstraktné dátové štruktúry používané v komplex-

ných heterogénnych architektúrach zvyčajne nie sú prehľadné a so zvyšovaním komplexnosti 

sa prehľad iba zhoršuje. Touto metódou by bolo možné zobraziť vnútornú štruktúru softvéru 

a odhaliť relevantné dáta, prípadne nekorektné operácie s nimi.  

1.2 Globálne ciele pre letný semester 

Zimný semester slúžil skôr na analýzu súčasného stavu a na korekcie zdrojových kódov. 

Stihli sme nemalú časť projektu refaktorovať a opraviť vyskytnuté chyby. V letnom semestri 

sa budeme venovať implementácii nových modulov a funkcionalít, ktoré zvýšia existujúcemu 

projektu 3DSoftViz hodnotu. 

Našim cieľom je stihnúť naprogramovať rozrobenú 3D myš na najpoužívanejšie plat-

formy. Myška má byť naimplementovaná ako samostatný modul systému, čo najmenej závislý 

od hlavnej časti programu. 

Medzi ďalšie prvky, ktoré sa pokúsime nasadiť patria okuliare rozšírenej reality Vuzix. 

Okuliare slúžia ako zobrazovacie zariadenie s fixovanou kamerou, ktoré sú schopné sledovať 

pohyby používateľa. Našou úlohou je nájsť ideálne riešenie ako zakomponovať Vuzix okuliare 
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do projektu. Popri rozšírenej reality sa budeme venovať aj 3D zobrazeniu. Máme k dispozícií 

Nvidia 3D Vision Pro okuliare, ktoré ponúkajú 3D stereoskopické zobrazenie. Pomocou tohto 

zariadenia budeme môcť vidieť vizualizované grafy v 3D. 

Počas semestra sa bude pracovať aj na rozšírenom zobrazení typu WALL, keďže konfi-

gurácia pre typ CAVE je momentálne nemožná. Ideou je zobraziť projekt na viacerých moni-

toroch/projektoroch. A v poslednom rade sa pozrieme na leap senzor. Okrem refaktorovanie 

existujúceho modulu sa budeme snažiť doplniť ďalšie funkcionality použitím práve tohto sní-

mača. 
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2 Celkový pohľad na systém 

V tejto kapitole sa nachádza celkový pohľad na systém z hľadiska architektúry, dátového 

modelu, diagramu tried a jednotlivých modulov projektu. 

2.1 Architektúra 

Na Obrázku 1 je zobrazená štruktúra projektu, ktorá bola štartovacím bodom pre náš pro-

jekt. Pracujeme na rozšírení projektu o nové moduly ako je 3D myš, pomocou ktorej sa zefek-

tívni ovládanie programu, teda manipulácia s grafmi vo virtuálnom priestore. Následne sa pra-

covalo na úpravách existujúcich komponentoch, aby sme pripravili softvér na implementáciu 

nových častí. Vyriešili sme chyby, ktoré nedovoľovali využívanie celého potenciálu softvéru 

3DSoftViz.  

 

Obrázok 1 - architektúra softvéru 
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2.2 Dátový model 

Dátový model databázy sme prebrali od predchádzajúcich prác, zobrazený je na Obrázku 2.  

 

Obrázok 2 - dátový model 

Stručný opis vybraných entít:  

 Graphs – predstavuje jednotlivé záznamy grafov  

 Layouts– obsahuje layout pre daný graf. Layout predstavuje konkrétne rozloženie mno-

žiny uzlov a hrán grafu v priestore.  

 Nodes– obsahuje uzly a typy v grafe. Graf je vytvorený z množiny uzlov poprepájaných 

hranami, pričom každý uzol má svoj typ.  

 Positions – obsahuje súradnice uzlov v priestore, pričom pozostáva z troch súradníc, 

ktoré sú naviazané na konkrétny uzol a layout. 

 Edges – má uložené hrany spájajúce uzly v grafe. Hrana môže byť orientovaná neorien-

tovaná a má začiatočný a koncový uzol a tiež typ.  
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2.3 Diagram tried 

 

Obrázok 3 - diagram tried 

Diagram tried je rozdelený do troch veľkých celkov:  

 OpenCV - hlavný celok, ktorý obsahuje základné triedy (core) pre celú funkcionalitu 

projektu  

 Model Aruco - triedy obsahujúce funkcionalitu pre rozpoznávanie značiek, bežia vo 

vlastnom vlákne  

 QOpenCv - obsahuje triedy pre vlákno na rozoznávanie tváre, spolu so samostatným 

vykresľovaním  
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3 UML diagramy 

 

Obrázok 4 – Cluster 

 

Obrázok 5 – Edge 
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Obrázok 6 - Node 

 

Obrázok 7 - Layout 1 

 

Obrázok 8 - Layout 2 
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Obrázok 9 - Layout 3 

 

Obrázok 10 - Layout visitor 

 

Obrázok 11 - Leap senzor 

LeapThread dedí od QThread - include Leap, LeapController - vytvára samostatný thread 

pre leap senzor 

LeapListener dedí od Listener - include Leap, LeapActions, DirectionDetector, Finger-

PositionDetector – prekonáva funkcie Listenera, ktoré sa starajú o zmenu stavu leap senzora 

LeapController dedí od Controller - include Leap, LeapListener - spúšta a zastavuje po-

čuvanie leap senzora 

LeapAction - include DirectionDetector, MouseControl, CameraManipulator, Leap, 

Math, Core - obsahuje funkcie, ktoré sa vykonávajú na základe detegovaného gesta 
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FingerPositionDetector - include Leap - obsahuje funkcie na prácu s pozíciou prstov 

DirectionDetector - include Leap, LeapMath - obsahuje funkcie na prácu s natočením 

rôznych častí ruky 

 

Obrázok 12 – Network 

 

Obrázok 13 – CoreWindow 

 

Obrázok 14 - QOSG 



   

 

 

14 

 

 

Obrázok 15 - QOSG complete 

 

Obrázok 16 – Viewer complete 

 

Obrázok 17 – GitLib 
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Obrázok 18 - 3D mouse Linux 

 

Obrázok 19 - 3D mouse Windows 
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Obrázok 20 – AppCore 

 

Obrázok 21 – ArucoModul 
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Obrázok 22 – Clustering 

 

Obrázok 23 – Importer 

 

Obrázok 24 – Kinect 
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Obrázok 25 – Lua 

 

Obrázok 26 – Manager 
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Obrázok 27 – Noise 

 

Obrázok 28 – OpenCV 
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Obrázok 29 – OSGQtBrowser 

 

Obrázok 30 – QopenCV 

 

Obrázok 31 - Util 
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4 Prehľad modulov 

4.1 Implementované moduly 

Core – obsahuje jadro systému, inicializuje základné časti systému. 

Data - dátový modul pre opis štruktúry grafu, obsahujúci triedy reprezentujúce jednotlivé prvky 

grafu (graph, node, edge, type, layout, ...). 

Importer - modul pre parsovanie vstupných súborov vo formátoch GraphML, RSF a GXL. 

Layout – modul, ktorý má na starosti rozmiestňovanie uzlov v 3D priestore, taktiež obsahuje im-

plementácie layout algoritmu a triedy pre pridávanie ohraničení rozmiestnenia. 

Manager - modul pre prácu s grafom.  

Math - model pre rozšírenie práce s kamerou.  

Model – modul pre komunikáciu systému s databázou. Funkcionalitou je mapovanie objektov do 

databázy, vytvorenie spojenia s databázou a základne funkcie výberu a uloženia grafu. Taktiež 

umožňuje uloženie uzlov aj s ich atribútmi a viacero rozmiestnení pre 1 graf. 

Network - modul pre podporu kolaboratívnej práce nad grafom. Poskytuje klient/server funkcio-

nalitu. 

Noise - modul pre vytvorenie generovaného 3D priestoru pre pozadie. 

OsgBrowser - modul zahŕňa viazanie udalostí pre jednotlivé klávesy a akcie myši medzi rozhra-

niami Qt a OpenSceneGraph a vizualizáciu načítaných grafov.  

QOSG – modul pre prácu s grafickými prvkami softvéru. Má na starosti vytvorenie hlavného okna 

a prácu s pomocnými oknami a widgetami.  

Util - zabezpečuje konfiguráciu nastavení aplikácie a funkcie pre vyčistenie pamäte. 

Viewer - modul zabezpečuje pohyb v 3D priestore a prácu s kamerou. V module sa tiež pripravuje 

graf a jeho pre zobrazenie a vytvorenie 3D kocky pre pozadie. 
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Kinect – modul pre komunikáciu a ovládanie zariadenia Kinect. Medzi jeho funkcionalitu patrí 

získavanie informácií a ich nasledovné spracovanie. Obsahuje detegovanie gest, ktoré nahrádzajú 

ovládanie myšou, otáčanie a pohyb grafu a gestá pre ďalšie ovládanie. 

Speech - implementuje funkcionalitu rozpoznávania hlasu. 

OpenCV - zabezpečuje rozpoznávanie tváre na obraze z kamery a poskytuje funkcionalitu pre 

správu kamier. 

QOpenCV – obsahuje okno pre ovládanie rozpoznávania tváre, značky a ovládanie video po-

zadia  

Aruco – obsahuje funkcionalitu, ktorá vie rozpoznávať značky z kamery použitím knižnice 

Aruco. 

5DTGloves – zabezpečuje detegovanie gesta ruky a vykonávanie korešpondujúcich akcií. 

Leap senzor – deteguje dve ruky používateľa v 3D priestore a sleduje pohyby rúk až na úroveň 

článkov prstov. 

3D myš – poskytuje ovládanie kamery pomocou tohto zariadenia   

4.2 Podporované nové zariadenia 

Nvidia 3D Vision PRO – slúžia na zobrazenie scény v 3D pomocou špeciálnych okuliarov 

Vuzix STAR 1200XL – umožňuje zobraziť scénu s grafmi do rozšírenej reality 
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5 Moduly a funkcionality systému 

5.1 Mouse3d 

K dispozícií máme dva modely počítačových 3D myší. Kompaktný Space Navigator for 

notebooks je pre svoje malé rozmery ľahko prenosný. Na druhej strane, Space Pilot Pro je mo-

hutnejšia myš obohatená o niekoľko tlačidiel naviac. Pre obe zariadenia slúži rovnaké SDK. 

5.1.1 Analýza modulu Mouse3d 

Mouse3d je samostatný implementačný modul v projekte 3dSoftviz zodpovedný za pri-

pojenie funkcionality 3d myši. Pri využívaní priestorových údajov je podpora efektívnej mani-

pulácie s 3d modelmi nevyhnutná pre projekt. Modul tvorí rozhranie pre pripojenie myši nezá-

vislé na konkrétnom produkte. Jeho účelom je zachytávanie a spracúvanie signálov z 3d myši 

a ich interpretácia pre 3dSoftviz. Spolu s modulom je vytváraná knižnica pre prácu so Space-

Navigator for Notebooks a Space Pilot Pro myšou od spoločnosti 3dConnexion. Knižnica Lib-

Mouse3d slúži ako prostriedok na komunikáciu modulu 3dMouse s funkcionalitou SpaceNavi-

gator. V rámci vývoja nám spoločnosť na požiadavku poskytla SDK pre tento hardvér. 

5.1.2 Návrh modulu Mouse3d 

Pri návrhu sme sa inšpirovali predošlými funkčnými modelmi. Identifikovali sme skupinu 

tried Mouse3d, ktoré budú zabezpečovať rozhranie medzi projektom 3dSoftviz a súbormi 3d 

myši. Toto je nevyhnutné kvôli tomu, aby mohla byť zo súborov 3d myši vytvorená samo-

statná knižnica. Skupina tried v balíku Mouse3d slúži na spracovanie signálu získaného zo špe-

ciálnej myšky do použiteľnej podoby pre náš projekt. LibMouse3d obsahuje rozhrania, ktoré 

oddeľujú aplikačnú logiku myšky od samotného softvéru. V balíku sú umiestnené aj triedy slú-

žiace na namapovanie ovládania pomocou 3D myši – budovanie aplikácie však kvôli multip-

latformovému návrhu však pracuje vždy len s jednou skupinou súborov mimo štandardného 

rozhrania. Usporiadanie takýmto spôsobom je prospešné pre projekt z hľadiska modularity. 

Takto sa vytvorí modul Mouse3d, ktorý môže byť zaradený medzi ostatné. Z adresára LibMo-

use3d sa v projekte vytvára samostatne spustiteľná knižnica. 
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Obrázok 32 - triedy modulu 3dMouse pre Linux 

 

Obrázok 33 - triedy modulu 3dMouse pre Windows 
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5.1.3 Implementácia 

Implementovali sme moduly systému z diagramov na obrázku 32 a 33 a integro-

vali ich do projektu. Jednotlivé diagramy reprezentujú platformovo nezávislý návrh bu-

dovania aplikácie v závislosti na definovanej platforme. 

 Pri implementácií sme narazili na nedostatok vo vývojárskom balíčku produktu, 

ktorý znemožňoval správnu detekciu produktu v priamej spolupráci s Qt systémom pre 

budovanie aplikácie. Po negatívnej skúsenosti s podporným tímom pre 3D myš sme sa 

rozhodli preskúmať a implementovať alternatívne riešenia pre integráciu do Qt apliká-

cie. Všetky ostatné moduly boli napísané a obsahujú základnú funkcionalitu. Architek-

túra je však navrhnutá tak, aby bolo jednoduché ich rozšíriť a zmeniť. 

 Mouse3dDevice predstavuje triedu obaľujúcu multiplatformové riešenie. Obsa-

huje tvorbu entity podmienenej detegovanou platformou. Tá následne využíva pre prácu 

s driverom programové riešenie pre túto platformu. 

Windows implementácia pozostáva z open source MVC reimplementácie SDK pre 

prácu s Qt. Originálne riešenie pochádza od Davida Dibbena a je odporúčané aj na ofi-

ciálnom podpornom fóre zariadenia.   (http://www.codegardening.com/2011/02/using-

3dconnexion-mouse-with-qt.html). Komunikácia s aplikáciou je riešená pomocou Qt 

funkcionality signal – slot.   

Linux implementácia využíva natívny X11 driver pre správu okien, ktorý je schopný 

zachytávať signály pomocou správ knižnice Magelan. Riešenie si vyžaduje reimple-

mentovanie metódy z triedy QApplication nazvanej X11EventFilter. Tá pasívne zachy-

táva tieto správy, ktoré sa následne preposielajú na spracovanie implementovanému mo-

dulu. 

5.2 Stereoskopické 3D s AR okuliarmi Vuzix STAR 1200XL 

5.2.1 Analýza 

Vuzix okuliare sú zariadenie pre rozšírenú realitu. Pozostávajú z dvoch displejov ktoré 

zobrazujú obraz pred očami z pripojeného počítača. Podporujú tri režimy zobrazovania. Prvým 

http://www.codegardening.com/2011/02/using-3dconnexion-mouse-with-qt.html
http://www.codegardening.com/2011/02/using-3dconnexion-mouse-with-qt.html
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je normálne 2D zobrazenie, ktoré zobrazuje rovnaký obraz na oba displeje. Ďalšie dva režimy 

sú 3D režimy. Jeden je top-bottom režim ktorý zobrazuje vrhnú polovicu obrazovky počítača 

do pravého displeja a spodnú polovicu do ľavého displeja. Druhý je side-by-side režim, ktorý 

zobrazuje pravú polovicu obrazovky počítača na pravý displej a ľavú polovicu na pravý displej. 

Vhodným zobrazením stereo obrazu na počítači docielime 3D efekt. Okrem displejov je súčas-

ťou kamera, ktorá sníma obraz pred používateľom a modul ktorý sleduje aktuálnu pozíciu oku-

liarov v priestore. 

5.2.2 Návrh 

Pre 3D zobrazenie grafov v 3DSoftviz navrhujeme využiť 3D režimy Vuzix okuliarov. 

Okuliare sa pre pripojený počítač javia ako zobrazovacie zariadenie, ktoré zobrazuje aktuálny 

obraz, je teda potrebné na strane 3DSoftviz zabezpečiť správne rozdelenie obrazu na polovice 

ktoré sú vzájomne posunuté a tým docielime efekt stereoskopického 3D. Pre takéto rozdelenie 

existuje priamo podpora v OSG, kde je potrebné nastaviť len správnu konfiguráciu, čo znamená 

typ 3D – horizontálne alebo vertikálne (čo sa mapuje na Vuzix ako top-bottom a side-by-side), 

a hodnoty pre správny 3D efekt – vzdialenosť od obrazovky (v prípade Vuzix okuliarov to sú 

3 metre), a fyzická veľkosť obrazovky (Vuzix vytvára virtuálny obraz s uhlopriečkou 190cm s 

pomerom strán 16:9). Kameru okuliarov je možné využívať v iných moduloch 3DSoftvizu, 

pretože z pohľadu pripojených zariadení sa javí ako normálna USB kamera. Modul pre sledo-

vanie pozície okuliarov momentálne nevyužijeme. 
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5.2.3 Implementácia 

Zobrazenie scény v režime 3D je priamo podporované v OSG. V našom projekte sme 

upravili triedu src/Viewer/PickHandler.cpp, kde sme pridali jednotlivé 3D módy (osg::Display-

Settings::StereoMode::“xxx“). Stereo mód sa nastavuje nasledovne: 

Prepínanie medzi 3D režimami je namapované na klávesu ‚G‘. Zobrazenie sa prepína 

medzi vertikálnym, horizontálnym rozdelením a vypnutím. 

Ďalšou zmenou je možnosť nastavenia vzdialenosti očí. Okuliare treba v niektorých prí-

padoch kalibrovať a o to sa postará nasledovný kód: 

 

//split stereo 3D 

else if ( ea.getKey() == osgGA::GUIEventAdapter::KEY_G ) { 

 if ( splitviewMode == 0 ) { 

  //turn on 

  osg::DisplaySettings::instance()->setStereoMode( 

osg::DisplaySettings::StereoMode::VERTICAL_SPLIT ); 

  osg::DisplaySettings::instance()->setScreenDistance( 

Util::ApplicationConfig::get()->getValue( "Display.Settings.Vuzix.Distance" ).toFloat() ); 

  osg::DisplaySettings::instance()->setScreenHeight( 

Util::ApplicationConfig::get()->getValue( "Display.Settings.Vuzix.Height" ).toFloat() ); 

  osg::DisplaySettings::instance()->setScreenWidth( 

Util::ApplicationConfig::get()->getValue( "Display.Settings.Vuzix.Width" ).toFloat() ); 

 

  qDebug() << "Turned on split stereo 3D - vertical split"; 

 } 

 else if ( splitviewMode == 1 ) { 

  osg::DisplaySettings::instance()->setStereoMode( 

osg::DisplaySettings::StereoMode::HORIZONTAL_SPLIT ); 

  qDebug() << "Turned on split stereo 3D - horizontal split"; 

  } 

 else { 

  //turn off 

  osg::DisplaySettings::instance()->setStereo( FALSE ); 

  //reset to default config 

  osg::DisplaySettings::instance()->setScreenDistance( 

Util::ApplicationConfig::get()->getValue( "Display.Settings.Default.Distance" ).toFloat() 

); 

  osg::DisplaySettings::instance()->setScreenHeight( 

Util::ApplicationConfig::get()->getValue( "Display.Settings.Default.Height" ).toFloat() ); 

  osg::DisplaySettings::instance()->setScreenWidth( 

Util::ApplicationConfig::get()->getValue( "Display.Settings.Default.Width" ).toFloat() ); 

  osg::DisplaySettings::instance()->setEyeSeparation( 

Util::ApplicationConfig::get()->getValue( "Display.Settings.Default.EyeSeparation" 

).toFloat() ); 

 

  qDebug() << "Turned off split stereo 3D"; 

 } 

 splitviewMode = ( splitviewMode + 1 ) % 3; //rotate modes : vertical / 

horizontal / off 

} 
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Klávesom H sa znižuje aktuálna hodnota vzdialenosti, ktorá je v metroch, o 0.001m, 

a klávesom J sa zvyšuje o rovnakú hodnotu. Potrebné údaje sú získavané z konfiguračného sú-

boru (resources/config/config), do ktoré sme pridali nasledovné riadky pre OSG zobrazovanie: 

Tieto nastavenia sú použité aj pri vypnutí 3D režimu, aby sa zobrazenie obnovilo do pô-

vodného stavu. Rovnako sa v súbore nachádzajú aj nastavenia pre okuliare Vuzix: 

Tieto hodnoty predstavujú veľkosť zobrazovacieho zariadenia a sú dôležité pre docielenie 

dobrého 3D efektu. 

5.3 Stereoskopické 3D s okuliarmi Nvidia 3D Vision Pro 

5.3.1 Analýza 

Okuliare 3D Vision využívajú quad buffer. Jedná sa o technológiu používanú v počítačo-

vej grafike pre implementácie stereoskopického renderovania. Pre stereoskopické renderovanie 

musí každé oko získavať samostatný obraz. Quad buffer využíva double buffering s predným 

a zadným buffrom synchronizovane pre každé oko. Takto dostávame 4 buffre. 

//adjust eye distance, 0.001m change 

else if ( ea.getKey() == osgGA::GUIEventAdapter::KEY_H && ( splitviewMode != 0 ) ) { 

 //- 

 float distance = osg::DisplaySettings::instance()->getEyeSeparation(); 

 distance = distance - 0.001f; 

 osg::DisplaySettings::instance()->setEyeSeparation( distance ); 

 qDebug() << "Eye distance : " << distance; 

} 

else if ( ea.getKey() == osgGA::GUIEventAdapter::KEY_J && ( splitviewMode != 0 ) ) { 

 //+ 

 float distance = osg::DisplaySettings::instance()->getEyeSeparation(); 

 distance = distance + 0.001f; 

 osg::DisplaySettings::instance()->setEyeSeparation( distance ); 

 qDebug() << "Eye distance : " << distance; 

} 

Display.Settings.Default.Distance=0.5 

Display.Settings.Default.Height=0.26 

Display.Settings.Default.Width=0.325 

Display.Settings.Default.EyeSeparation=0.06 

 

Display.Settings.Vuzix.Distance=3.048 

Display.Settings.Vuzix.Height=0.93 

Display.Settings.Vuzix.Width=1.66 
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5.3.2 Návrh 

OpenSceneGraph podporuje mnohé stereoskopické režimy, medzi ktoré patrí aj quad 

buffer (osg::DisplaySettings::StereoMode::QUAD_BUFFER). Tento režim funguje iba s kom-

patibilnými zariadeniami. Naša zostava pozostáva medzi inými aj z grafickej karty Nvidia Qu-

adro K5000 a monitoru BenQ XL2720Z (144Hz). Okrem prepnutia režimu sme museli upraviť 

parametre zobrazovača – QGLWidget. 

5.3.3 Implementácia 

Prepnutie na stereoskopické režim – quad buffer sme spojili s už existujúcim riešením pre 

AR okuliare. Pridali sme ďalší stav, do ktorého sa vieme dostať cez klávesu ‚G‘. Bola upravená 

trieda src/Viewer/PickHandler.cpp nasledovne: 

Museli sme vykonať zmenu aj pri vytváraní okna AdapterWidget, keďže pôvodné nasta-

venia nepodporovali tento režim. Trieda src/QOSG/AdapterWidget.cpp: 

5.4 Multiview „Wall“ 

5.4.1 Analýza 

Zobrazenie pomocou viacerých monitorov, resp. projektorov sa dá docieliť pomocou roz-

loženia „CAVE“ alebo „WALL“. V našom prípade sa budeme zaoberať typom WALL. Pri 

//split stereo 3D 

else if ( ea.getKey() == osgGA::GUIEventAdapter::KEY_G ) { 

 if ( splitviewMode == 0 ) { 

  osg::DisplaySettings::instance()->setStereoMode( 

osg::DisplaySettings::StereoMode::QUAD_BUFFER ); 

  osg::DisplaySettings::instance()->setStereo( TRUE ); 

  qDebug() << "Turned on quad buffer stereo 3D"; 

 } 

 ... 

AdapterWidget::AdapterWidget( QWidget* parent, const char* name , const QGLWidget* 

shareWidget, WindowFlags f ) : 

#if QT_VERSION > 0x040000 

 QGLWidget( QGLFormat( QGL::DoubleBuffer | QGL::DepthBuffer | QGL::Rgba | 

QGL::StencilBuffer | QGL::AlphaChannel | QGL::StereoBuffers ), parent, shareWidget, f ) 

#else 

 QGLWidget( parent, shareWidget, f ) 

#endif 

{ 

 _gw = new osgViewer::GraphicsWindowEmbedded( 0,0,width(),height() ); 

 setFocusPolicy( Qt::StrongFocus ); 

} 
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tomto rozložení sa používa symetrické perspektívne zobrazenie (symmetric frustum). Na 

správne zobrazenie potrebujeme nepárne množstvo zobrazovacích zariadení. Najideálnejšie rie-

šenie by bolo vytvorenie x ďalších okien, v ktorých by sa kamery správne nakonfigurovali. 

Bohužiaľ, náš aktuálny systém túto opciu neumožňuje, kvôli hlbokej integrácií OSQ do Qt po-

užívateľského rozhrania. Jediným riešením je roztiahnutie jedného okna na potrebnú veľkosť. 

V existujúcom kóde sme našli triedu src/Viewer/ViewerQt.cpp, ktorá sa aktuálne zaoberá sa 

nastavovaním kamery a viewportov.  

    

5.4.2 Návrh 

Naše riešenie spočíva v rozdelení viewportu na toľko ekvivalentných častí, s koľkými 

monitormi/projektormi pracujeme. Následne vytvoríme určitý počet kamier, ktoré sa budú sprá-

vať ako slave kamery relatívne od hlavnej kamery. Slave kamery sú posunuté do jedného a dru-

hého smeru, aby sa neprekrývali. Ilustrácia výslednej zostavy kamier je znázornená na tomto 

obrázku (pre 3 kamery): 
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5.4.3 Implementácia 

Na dosiahnutie požadovaného cieľa sme museli modifikovať triedu src/Viewer/Vie-

werQt.cpp. Nastavenie potrebných premenných: 

V implementácií sa ráta aj s prípadnou chybou pri delení nepárnym číslom a následným 

zaokrúhlením na celé čísla (divisionError). Master kamera je vždy stredná, ďalšie sa posúvajú 

double fovy = 60.0; 

double nearClippingPlane = 0.01; 

double farClippingPlane = appConf->getValue( "Viewer.Display.ViewDistance" ).toFloat(); 

double aspectRatio = static_cast<double>( width() )/static_cast<double>( height() ); 

if ( appConf->getValue( "Viewer.Display.Multiview" ).toInt() ) { 

 int screenNum = appConf->getValue( "Viewer.Display.ScreenNum" ).toInt(); 

 int divisionError = width() % screenNum; 

 

 //LEFT CAMERAS 

 //0, 1 = i 

 for ( int i=0; i<screenNum/2; i++ ) { 

  osg::ref_ptr<osg::Camera> leftCam = new osg::Camera; 

  leftCam->setViewport( new osg::Viewport( ( width()/screenNum + 

divisionError ) * i, 0, width()/screenNum + divisionError, height() ) ); 

  leftCam->setGraphicsContext( getGraphicsWindow() ); 

  leftCam->setProjectionMatrixAsPerspective( fovy, aspectRatio, 

nearClippingPlane, farClippingPlane ); 

  leftCam->setViewMatrix( osg::Matrix::lookAt( osg::Vec3d( -10, 0, 0 ), 

osg::Vec3d( 0, 0, 0 ), osg::Vec3d( 0, 1, 0 ) ) ); 

  osgViewer::Viewer::addSlave( leftCam.get(), osg::Matrix::translate( 2.0 

* ( screenNum/2-i ), 0.0, 0.0 ), osg::Matrix() ); 

 } 

 

 //MIDDLE (MASTER) CAMERA 

 //2 = screenNum/2 

 getCamera()->setViewport( new osg::Viewport( ( width()/screenNum + divisionError 

) * ( screenNum/2 ), 0, width()/screenNum + divisionError, height() ) ); 

 getCamera()->setGraphicsContext( getGraphicsWindow() ); 

 getCamera()->setProjectionMatrixAsPerspective( fovy, aspectRatio, 

nearClippingPlane, farClippingPlane ); 

 getCamera()->setViewMatrix( osg::Matrix::lookAt( osg::Vec3d( -10, 0, 0 ), 

osg::Vec3d( 0, 0, 0 ), osg::Vec3d( 0, 1, 0 ) ) ); 

 

 //RIGHT CAMERAS 

 //3, 4 = screenNum/2 + 1 + i 

 for ( int i=0; i<screenNum/2; i++ ) { 

  osg::ref_ptr<osg::Camera> rightCam = new osg::Camera; 

  rightCam->setViewport( new osg::Viewport( ( width()/screenNum + 

divisionError ) * ( screenNum/2 + 1 + i ), 0, width()/screenNum + divisionError, height() 

) ); 

  rightCam->setGraphicsContext( getGraphicsWindow() ); 

  rightCam->setProjectionMatrixAsPerspective( fovy, aspectRatio, 

nearClippingPlane, farClippingPlane ); 

  rightCam->setViewMatrix( osg::Matrix::lookAt( osg::Vec3d( -10, 0, 0 ), 

osg::Vec3d( 0, 0, 0 ), osg::Vec3d( 0, 1, 0 ) ) ); 

  osgViewer::Viewer::addSlave( rightCam.get(), osg::Matrix::translate( -

2.0 * ( i+1 ), 0.0, 0.0 ), osg::Matrix() ); 

 } 

} 
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o hodnotu 2.0 * poradie kamery. Zapnutie/vypnutie režimu multiview, počet kamier a rozlíše-

nie použitých monitorov/projektorov sa nastavuje v konfiguračnom súbore resources/con-

fig/config. 

 

5.5 Refaktorovanie modulu Leap 

Hlavným cieľom refaktorovania modulu Leap je oddelenie do samostatnej knižnice ktorá 

nemá žiadne závislosti na zvyšok 3Dsoftviz. Druhým cieľom bola optimalizácia kódu na efek-

tivitu a rýchlosť. 

Oddelenie závislostí bolo dosiahnuté vytvorením nového abstraktného rozhrania , ktorého 

metódy sú volané v kóde tam, kde boli závislosti (napr. manipuláciu s kamerou). Závislosti sú 

až v samotnej implementácií rozhrania, ktoré je súčasťou 3Dsoftviz. 

Viaceré metódy v triedach Leap modulu boli upravené a optimalizované. Zjednodušili 

sme podmienky a zefektívnili algoritmy so zachovaním rovnakej funkcionality. Pre multiplat-

formovú podporu sme tiež refaktorovali použitie WIN32 knižnice pre uspávanie vlákna. Uspá-

vanie je nutné pre lepšiu detekciu pohybu ruky SDK Leap-u. Použili sme chránané funkcie 

QThread, ktoré sme obalili do vlastnej triedy: 

  

Viewer.Display.Multiview=0 

Viewer.Display.ScreenNum=3 

Viewer.Display.MaxScreenWidth=1920 

Viewer.Display.MaxScreenHeight=1080 
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Pre kompiláciu do samostatnej knižnice bol upravený súbor CMakeLists.txt 

5.6 Dynamická zmena pozadia 

Cieľom je možnosť zmeny pozadia na napríklad čiernu farbu počas behu programu. Do-

teraz bolo toto možné len pomocou zmeny konfigurácie programu a jeho zapnutím/vypnutím. 

Implementovali sme teda úplne nové textúry resp. SkyBox, ktorý je len čierny alebo biely, 

podľa toho aká ma byť zmena pozadia. Pri požiadavke na zmenu pozadia sa zastaví layoutovací 

algoritmus pre rozmiestnenie vrcholov grafu v scéne. Následne sa odstráni z grafu scény po-

sledný uzol, ktorý vždy reprezentuje aktuálne pozadie scény. Vytvorí sa nový SkyBox - pozadie 

s požadovanou textúrou, tento SkyBox sa pridá na koniec grafu scény. Následne sa obnoví 

layoutovací algoritmus, zatiaľ čo bolo pozadie zmenené. 

Pre každé pozadie bola vytvorená separátna funkcia, ktorá zabezpečuje logovanie a vyššie 

spomenuté operácie potrebné pre korektnú dynamickú zmenu pozadia. Tieto funkcie, rovnako 

ako aj pridanie menu pre ovládanie zmeny pozadia v aplikácií, bolo pridané do triedy 

#ifndef LEAPSLEEPER_H 

#define LEAPSLEEPER_H 

 

#endif // LEAPSLEEPER_H 

 

#include <QThread> 

 

class LeapSleeper : public QThread 

{ 

public: 

 static void usleep(unsigned long usecs){QThread::usleep(usecs);} 

 static void msleep(unsigned long msecs){QThread::msleep(msecs);} 

 static void sleep(unsigned long secs){QThread::sleep(secs);} 

}; 

void CoreWindow::switchBackgroundSkyBox() { 

 LOG(INFO) << "CoreWindow::switchBackgroundSkyBox switching to SkyBox bg"; 

 Data::Graph* currentGraph = Manager::GraphManager::getInstance()-

>getActiveGraph(); 

 

 int flagPlay = 0; 

 if (this->isPlaying) { 

  flagPlay = 1; 

  pauseLayout(); 

 } 

 if (coreGraph->updateBackground(0, currentGraph) == 0) { 

  LOG(INFO) << "Background successfully updated"; 

 } 

 else { 

  LOG(ERROR) << "Background bg update failed"; 

 } 

 if (flagPlay == 1) playLayout(); 

} 
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src/QOSG/CoreWindow.cpp. V triede src/Viewer/CoreGraph.cpp bola zmenená metóda upda-

teBackground tak aby pracovala s premennou bgVal, ktorá reprezentuje číselnú hodnotu navia-

zanú na pozadie, na ktoré má nastať zmena. 

 

 

int CoreGraph::updateBackground(int bgVal, Data::Graph* currentGraph) { 

 LOG(INFO) << "CoreGraph::updateBackground - updating background"; 

 

 osg::Group* root = this->getScene(); 

 if (root->removeChild(root->getNumChildren()-1) == true) { 

 

  if (bgVal == 0) { // default skybox 

   SkyBox* skyBox = new SkyBox; 

   root->addChild(skyBox->createSkyBox(0)); 

  } 

  else if (bgVal == 1) { // noise skybox 

   root->addChild(createSkyNoiseBox()); 

  } 

  #ifdef OPENCV_FOUND 

  else if (bgVal == 2) { 

   root->addChild(createTextureBackground()); 

  } 

  else if (bgVal == 3) { 

   root->addChild(createOrtho2dBackground()); 

  } 

  #endif 

  else if (bgVal == -1) { 

   SkyBox* skyBox = new SkyBox; 

   root->addChild(skyBox->createSkyBox(-1)); // black skybox 

  } 

  else if (bgVal == -2) { 

   SkyBox* skyBox = new SkyBox; 

   root->addChild(skyBox->createSkyBox(-2)); // white skybox 

  } 

 

  reload(currentGraph); 

  return 0; 

 } 

 

 return 1; 

} 



CHAPTER

ONE

PRE POUŽÍVATEL’OV

1.1 Inštalačný návod (VC10)

v1.5 (17. 11. 2015)

1.1.1 Changelog

v1.6 - 13.03.2016

• návod pre MS VisualStudio 2013

• aktualizovaný Qt (5.5.1)

v1.5 – 17.11.2015

• aktualizované Aruco využíva FreeGlut

• upravené nastavenie pre build v QtCreator

v1.4 - 27.10.2015

• aktualizovaná knižnica OSG (v3.4) – nahradené zdroje

• zmazaný import chýbajúcich knižníc

v1.3 - 11.10.2015

• pridaný krok vytvorenia build konfigurácie

v1.2 - 06.10.2015

• pridaný postup pre buildovanie OSG knižníc

• pripojený zdroj s uploadnutými OSG knižnicami

• zvýraznené dôležité poznámky

v1.1 - 28.09.2015

• doplnené obrázky

• aktualizované zdroje

• vyriešené chyby

• zmenené poradia krokov
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1.1.2 Časté problémy

Inštalácia softvéru 3DSoftViz pozostáva z mnohých krokov. Pozorné postupovanie podl’a inštrukcií je nevyhnutné,
inak sa môžu vyskytnút’ problémy. Nasledujúce problémy sme identifikovali.

Ponuka generátorov je prázdna

Ak sa generátor nedá vybrat’, je dôležité zmazat’ súbor CMakeLists.txt.user.2.5pre1 z %3DSoftViz% a zopakovat’
predošlý krok.

CMake - chýbajúce moduly

1. cez git shell prejst’ do %3DSoftViz%

2. uistit’ sa, že je nastavený na master vetvu

• na prepnutie: git checkout master

3. zadat’ príkaz: git submodule update –init

CMake - cesta nebola nájdená

Ak nebola nájdené cesta k niektorému modulu, treba skontrolovat’ nastavenia premenných v RapidEE.

Chyba spojená s glut.h, glut.lib, glut.dll

Pokial’ sa vyskytnú problémy typu:

• nevie nájst’ glut.h

• hlási chyby priamo v glut.h

• niečo iné s glut.h, glut.lib alebo glut.dll

Tak najjednoduchšie riešenie je premenovat’:

- %OSG_DIR%/ThirdParty/VC10/x86/include/GL/glut.h > ../glut.h.bak
- %OSG_DIR%/ThirdParty/VC10/x86/lib/glut32.lib > ../glut32.lib.bak
- %OSG_DIR%/ThirdParty/VC10/x86/lib/glut32D.lib > ../glut32D.lib.bak

Pri spustení crash programu s nullpoint exception

Pokial’ sa projekt spustí iba cez argument: -DCMAKE_BUILD_TYPE=Release, ale cez -
DCMAKE_BUILD_TYPE=Debug hlási nullpoint exception pri načítavaní obrázkov na pozadie a program
crashne. Tak riešením je znovu stiahnut’/nakonfigurovat’ OSG podl’a návodu.

Zm### pri buildovaní

Ak došlo k erroru pri buildovaní: -Zm###, treba vykonat’ úpravu v CMakeLists.txt > riadok 128 zmenit’ /Zm216 na
/Zm240 a spustit’ CMake odznovu.

4 Chapter 1. Pre používatel’ov
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1.1.3 Návod pre Windows

Tento návod bol úspešne otestovaný na operačných systémoch Windows 7, 8, 8.1, 10.

Potrebný softvér

Na inštaláciu potrebujeme klonovat’ projekt 3DSoftViz (Tím č.4 klonuje z /cimox/3dsoftviz) z Githubu a stiahnut’
nasledovné:

• CMake (v3.5.0)

• OpenSceneGraph (jeden z nasledujúcich)

– OpenSceneGraph (source) - iba zdrojové súbory -> treba buildnút’ (cca 40-50min)

– OpenSceneGraph (v3.4.0) - buildnuté (17.10.2015)

– OpenSceneGraph (v3.2.1)

• Kinect for Windows SDK 1.8

• Microsoft VisualStudio 2010 SP1 (okrem Express edition!)

• Qt (v4.8.5)

• QtCreator (v3.6.1)

• OpenCV (v2.4.10)

• Boost (v1.57.0)

• RapidEE - program na prácu s premennými prostredia

• Inštalácia knižnice 3rd party dependencies VC10

• OpenNI2

• NiTE2

• Debugging Tools for Windows

– WinDbg - Win 8.1

– WinDbg - Win 10

• FreeGlut

Postup inštalácie

1. Nainštalovat’ CMake. (Cesta je v dokumente označená ako %CMAKE_DIR%)

2. Nainštalovat’ Qt (%QT_DIR%)

3. Nainštalovat’ QtCreator do zložky Qt

4. Vytvorit’ zložku OpenSceneGraph (%OSG_DIR%) a %OSG_DIR%/ThirdParty

5. Rozbalit’ 3rd Party Knižnice (VC10) do %OSG_DIR%/ThirdParty/

6. Rozbalit’ FreeGlut do %OSG_DIR%/ThirdParty/VC10/x86

7. V prípade stiahnutia zbuildovaných súborov OSG (mega.nz)

(a) Rozbalit’ zložky build a install do %OSG_DIR%

(b) Vynechat’ nasledujúci krok.
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8. V prípade stiahnutia iba zdrojových súborov OSG (oficiálna stránka)

(a) Rozbalit’ OSG_3.4 do %OSG_DIR%

(b) Vytvorit’ zložku build a install v %OSG_DIR%

(c) Premenovat’ súbory:

%OSG_DIR%/ThirdParty/VC10/x86/include/GL/glut.h > ../glut.h.bak
%OSG_DIR%/ThirdParty/VC10/x86/lib/glut32.lib > ../glut32.lib.bak
%OSG_DIR%/ThirdParty/VC10/x86/lib/glut32D.lib > ../glut32D.lib.bak

(d) Spustit’ CMake (cmake-gui.exe)

i. source code > %OSG_DIR%/OSG_3.4

ii. binaries > %OSG_DIR%/build

iii. stlačit’ Configure (VS2010 kompilátor)

iv. stlačit’ Generate

• ak došlo k erroru: File > Delete Cache a skúsit’ znovu

(e) Nájst’ súbor OpenSceneGraph.sln v %OSG_DIR%/build

(f) Otvorit’ súbor vo VS2010

(g) Nastavit’ Solution Configuration na Debug

(h) Nájst’ projekt ALL_BUILD > pravý klik > build

(i) Po skončení nájst’ projekt INSTALL > pravý klik > build

(j) Nastavit’ Solution Configuration na Release

(k) Nájst’ projekt ALL_BUILD > pravý klik > build

(l) Po skončení nájst’ projekt INSTALL > pravý klik > build

(m) Presunút’ nainštalované súbory (default c:/Program Files (x86)/OpenSceneGraph) do
%OSG_DIR%/install

9. Rozbalit’ FreeGlut do %OSG_DIR%/ThirdParty/VC10/x86/ (prepísat’ súbory)

10. Nainštalovat’ OpenCV (%OPENCV_DIR%)

11. Rozbalit’ Boost (%BOOST_DIR%)

Ideálne je mat’ všetko na spoločnom mieste kvôli prehl’adnosti, napr.

12. Nainštalovat’ a otvorit’ RapidEE, v ktorom sa vykonajú tieto zmeny:

(a) do PATH pridat’ premenné:

i. %CMAKE_DIR%/bin

ii. %QT_DIR%/bin

iii. %QT_DIR%/Qtcreator/bin

iv. %OSG_DIR%/build/bin

v. %OSG_DIR%/ThirdParty/VC10/x86/bin

vi. %OPENCV_DIR%/build/x86/vc10/bin

(b) Vytvorit’ premennú CMAKE_INCLUDE_PATH a pridat’:
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Fig. 1.1: CMake pre OSG

Fig. 1.2: Nainštalovaný SW
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Fig. 1.3: PATH premenná

i. %OSG_DIR%/install/include

ii. %OSG_DIR%/ThirdParty/VC10/x86/include

iii. %OPENCV_DIR%/build/include

Fig. 1.4: CMAKE_INCLUDE_PATH premenná

(c) Vytvorit’ premennú CMAKE_LIBRARY_PATH a pridat’:

i. %OSG_DIR%/build/lib

ii. %OSG_DIR%/install/lib

iii. %OSG_DIR%/ThirdParty/VC10/x86/lib

iv. %OPENCV_DIR%/build/x86/vc10/lib

Fig. 1.5: CMAKE_LIBRARY_PATH premenná

(d) Vytvorit’ premennú BOOST_INCLUDEDIR a pridat’: %BOOST_DIR%/boost

(e) Vytvorit’ premennú BOOST_LIBRARYDIR a pridat’: %BOOST_DIR%/libs

(f) Vytvorit’ premennú BOOST_ROOT a pridat’: %BOOST_DIR%

(g) Vytvorit’ premennú OPENCV_DIR a pridat’: %OPENCV_DIR%/build

13. Naklónovat’ projekt 3DSoftViz cez git shell (%3DSoftViz%)

14. Vytvorit’ v priečinku %3DSoftViz% priečinky _build a _install
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Fig. 1.6: BOOST premmené

Fig. 1.7: OPENCV_DIR premenná

15. Spustit’ QtCreator. Tools > Options... > Build and Run:

(a) záložka CMake – zadat’ cestu %CMAKE_DIR%/bin/cmake.exe

(b) záložka Compilers – ak existuje VS2010 tak sú autodetected

(c) záložka Qt Versions – zadat’ cestu %QT_DIR%/bin/qmake.exe

(d) záložka Kits – vytvorit’ nový a vybrat’ hodnoty nasledovne:

Fig. 1.8: QtC Kits nastavenia

(e) záložka General – nastavit’ default build directory: %3DSoftViz%/_build

(f) Potvrdit’ – OK
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16. File > Open File or Project... > vybrat’ CMakeLists.txt z %3DSoftViz%

17. Zadat’ do pol’a Arguments jeden z nasledujúcich prepínačov:

• -DCMAKE_BUILD_TYPE=Debug

• -DCMAKE_BUILD_TYPE=Release

18. Vybrat’ z nastavený generátor – NMake Generator (názov kitu)

(Chyba: Generátor nebol nájdený <riešenie>)

19. Stlačit’ Run CMake

Fig. 1.9: QtC CMake wizard

(Chyba: Chýbajúce moduly <riešenie>)

(Chyba: Cesta nebola nájdená <riešenie>)

20. Ukončit’ – Finish

21. Vybrat’ Projects > Build & Run > Build, v časti Edit build configuration kliknút’ na Add > Clone selected,
nazvat’ napr. „unity“

22. Prejst’ na vytvorený build config. „unity“, v časti Build Steps otvorit’ Details a zaškrtnút’ pri build step jom.exe
možnost’ install_unity
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Fig. 1.10: QtC build project
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23. Skontrolovat’ nastavenie build config – unity

Fig. 1.11: QtC build config

24. Stačit’ Build (kladivko vl’avo dole)

25. Po úspešnom zbuildovaní vybrat’ Projects > Build & Run > Run, v časti Run pridat’ Add > Custom Executable
a nastavit’:

(a) executable: %3DSoftViz%/_install/bin/3DSoftviz.exe

(b) working directory: %3DSoftViz%/_install/bin/

26. Skontrolovat’ nastavenie run config – zadaná cesta

27. Spustit’ program pomocou zeleného tlačidla Run

1.1.4 Rozšírenie 3DSoftviz o Kinect

1. Nainštalovat’ Kinect for Windows

2. Skontrolovat’ v RapidEE či sa vytvorila premenná %KINECTSDK10_DIR%

3. Nainštalovat’ OpenNI2 (OpenNI-Windows-x86-2.2.msi)

• x86! – inak sa môžu vyskytnút’ problémy s linkovaním

4. Skontrolovat’ v RapidEE či sa vytvorili premenné:

(a) %OPENNI2_INCLUDE%

(b) %OPENNI2_LIB%

(c) %OPENNI2_REDIST%

(d) %OPENNI2_ROOT%

5. Nainštalovat’ NiTE2 (NiTE-Windows-x86-2.2.msi)

• x86! – inak sa môžu vyskytnút’ problémy s linkovaním
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Fig. 1.12: QtC run project

Fig. 1.13: QtC run config

Fig. 1.14: KINECTSDK10_DIR premenná
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Fig. 1.15: NITE2 premenné

6. Skontrolovat’ v RapidEE či sa vytvorili premenné:

(a) %NITE2_INCLUDE%

(b) %NITE2_LIB%

(c) %NITE2_REDIST%

(d) %NITE2_ROOT%

Fig. 1.16: OPENNI2 premenné

7. Pridat’ do premennej CMAKE_INCLUDE_PATH:

(a) %OPENNI2_INCLUDE%

(b) %NITE2_INCLUDE%

Fig. 1.17: OPENNI2 premenné

8. Pridat’ do premennej CMAKE_LIBRARY_PATH:

(a) %OPENNI2_ROOT%/Driver
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(b) %OPENNI2_REDIST%

(c) %OPENNI2_REDIST%/OpenNI2/Drivers

(d) %OPENNI2_LIB%

(e) %NITE2_ROOT%/Samples/Bin/OpenNI2/Drivers

(f) %NITE2_LIB%

Fig. 1.18: OPENNI2 premenné

9. Pridat’ do premennej PATH:

(a) %OPENNI2_REDIST%/OpenNI2/Drivers

(b) %OPENNI2_REDIST%

(c) %NITE2_REDIST%

(d) %NITE2_ROOT%/Samples/Bin

Fig. 1.19: OPENNI2 premenné

10. Spustit’ CMake a skontrolovat’ vo výpise:

(a) OpenNI2 FOUND
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(b) NITE2 FOUND

(c) KINECTSDK FOUND

1.1.5 Nastavenie debuggera v QtCreator

1. Nainštalovat’ WinDbg

2. Skontrolovat’ v QtCreator Tools > Options > Build & Run > záložka Debuggers či sú autodetected

Fig. 1.20: QtC debugger nastavenia

3. Pridat’ do QtCreator Tools > Options > Build & Run > záložka Kits pre vytvorený profil položku Debugger
(x86)

4. Spustit’ CMake (-DCMAKE_BUILD_TYPE=Debug)

5. Zvolit’ možnost’ Debug (vl’avo dole medzi Run a Build)

1.2 Inštalačný návod (VC12)

v1.6 (13. 03. 2016)

1.2.1 Návod pre Windows

Tento návod bol úspešne otestovaný na operačných systémoch Windows 7, 8, 8.1, 10.
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Potrebný softvér

Na inštaláciu potrebujeme klonovat’ projekt 3DSoftViz (Tím č.4 klonuje z /cimox/3dsoftviz) z Githubu a stiahnut’
nasledovné:

• CMake (v3.5.0)

• OpenSceneGraph (jeden z nasledujúcich)

– OpenSceneGraph (source) - iba zdrojové súbory -> treba buildnút’ (cca 40-60min)

– stable release: OpenSceneGraph (v3.4.0) - buildnuté (13.03.2016)

– developer release: OpenSceneGraph (v3.5.1) - buildnuté (13.03.2016)

• Kinect for Windows SDK 1.8

• Microsoft VisualStudio 2013 (okrem Express edition!)

• Qt (v4.8.6)

• QtCreator (v3.6.1)

• OpenCV (v2.4.10)

• Boost (v1.57.0)

• RapidEE - program na prácu s premennými prostredia

• Inštalácia knižnice 3rd party dependencies VC12

• OpenNI2

• NiTE2

• Debugging Tools for Windows

– WinDbg - Win 8.1

– WinDbg - Win 10

Postup inštalácie

1. Nainštalovat’ CMake. (Cesta je v dokumente označená ako %CMAKE_DIR%)

2. Nainštalovat’ Qt (%QT_DIR%)

3. Nainštalovat’ QtCreator do zložky Qt

4. Vytvorit’ zložku OpenSceneGraph (%OSG_DIR%)

5. V prípade stiahnutia zbuildovaných súborov OSG (mega.nz)

(a) Rozbalit’ zložky build a install do %OSG_DIR%

(b) Vynechat’ nasledujúci krok.

6. V prípade stiahnutia iba zdrojových súborov OSG (oficiálna stránka)

(a) Rozbalit’ OSG do %OSG_DIR%/source

(b) Vytvorit’ zložku build a install v %OSG_DIR%

(c) Rozbalit’ 3rd Party Knižnice (VC12) do %OSG_DIR%/ThirdParty/

(d) Spustit’ CMake (cmake-gui.exe)

i. source code > %OSG_DIR%/source
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ii. binaries > %OSG_DIR%/build

iii. stlačit’ Configure (VS2013 kompilátor)

iv. nastavit’ 3rdParty na %OSG_DIR%/ThirdParty/VC12/X86

v. stlačit’ Generate

• ak došlo k erroru: File > Delete Cache a skúsit’ znovu

Fig. 1.21: CMake pre OSG

(e) Nájst’ súbor OpenSceneGraph.sln v %OSG_DIR%/build

(f) Otvorit’ súbor vo VS2013 (ako správca!)

(g) Nastavit’ Solution Configuration na Debug

(h) Nájst’ projekt ALL_BUILD > pravý klik > build

(i) Po skončení nájst’ projekt INSTALL > pravý klik > build

(j) Nastavit’ Solution Configuration na Release
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(k) Nájst’ projekt ALL_BUILD > pravý klik > build

(l) Po skončení nájst’ projekt INSTALL > pravý klik > build

(m) Presunút’ nainštalované súbory (default c:Program Files (x86)OpenSceneGraph) do %OSG_DIR%/install

7. Nainštalovat’ OpenCV (%OPENCV_DIR%)

8. Rozbalit’ Boost (%BOOST_DIR%)

Ideálne je mat’ všetko na spoločnom mieste kvôli prehl’adnosti, napr.

Fig. 1.22: Nainštalovaný SW

9. Nainštalovat’ a otvorit’ RapidEE, v ktorom sa vykonajú tieto zmeny:

(a) do PATH pridat’ premenné:

i. %CMAKE_DIR%/bin

ii. %QT_DIR%/bin

iii. %QT_DIR%/Qtcreator/bin

iv. %OSG_DIR%/build/bin

v. %OSG_DIR%/ThirdParty/VC12/x86/bin

vi. %OPENCV_DIR%/build/x86/vc12/bin

Fig. 1.23: PATH premenná

(b) Vytvorit’ premennú CMAKE_INCLUDE_PATH a pridat’:

i. %OSG_DIR%/install/include
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ii. %OSG_DIR%/ThirdParty/VC12/x86/include

iii. %OPENCV_DIR%/build/include

Fig. 1.24: CMAKE_INCLUDE_PATH premenná

(c) Vytvorit’ premennú CMAKE_LIBRARY_PATH a pridat’:

i. %OSG_DIR%/build/lib

ii. %OSG_DIR%/install/lib

iii. %OSG_DIR%/ThirdParty/VC12/x86/lib

iv. %OPENCV_DIR%/build/x86/vc12/lib

Fig. 1.25: CMAKE_LIBRARY_PATH premenná

(d) Vytvorit’ premennú BOOST_INCLUDEDIR a pridat’: %BOOST_DIR%/boost

(e) Vytvorit’ premennú BOOST_LIBRARYDIR a pridat’: %BOOST_DIR%/libs

(f) Vytvorit’ premennú BOOST_ROOT a pridat’: %BOOST_DIR%

Fig. 1.26: BOOST premmené

(g) Vytvorit’ premennú OPENCV_DIR a pridat’: %OPENCV_DIR%/build

10. Naklónovat’ projekt 3DSoftViz cez git shell (%3DSoftViz%)

11. Vytvorit’ v priečinku %3DSoftViz% priečinky _build a _install

12. Spustit’ QtCreator. Tools > Options... > Build and Run:

(a) záložka CMake – zadat’ cestu %CMAKE_DIR%/bin/cmake.exe

(b) záložka Compilers – ak existuje VS2013 tak sú autodetected
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Fig. 1.27: OPENCV_DIR premenná

(c) záložka Qt Versions – zadat’ cestu %QT_DIR%/bin/qmake.exe

(d) záložka Kits – vytvorit’ nový a vybrat’ hodnoty nasledovne:

Fig. 1.28: QtC Kits nastavenia

(e) záložka General – nastavit’ default build directory: %3DSoftViz%/_build

(f) Potvrdit’ – OK

13. File > Open File or Project... > vybrat’ CMakeLists.txt z %3DSoftViz%

14. Zadat’ do pol’a Arguments jeden z nasledujúcich prepínačov:

• -DCMAKE_BUILD_TYPE=Debug

• -DCMAKE_BUILD_TYPE=Release

15. Vybrat’ z nastavený generátor – NMake Generator (názov kitu)

(Chyba: Generátor nebol nájdený <riešenie>)

16. Stlačit’ Run CMake

(Chyba: Chýbajúce moduly <riešenie>)

(Chyba: Cesta nebola nájdená <riešenie>)
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Fig. 1.29: QtC CMake wizard
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17. Ukončit’ – Finish

18. Vybrat’ Projects > Build & Run > Build, v časti Edit build configuration kliknút’ na Add > Clone selected,
nazvat’ napr. „unity“

19. Prejst’ na vytvorený build config. „unity“, v časti Build Steps otvorit’ Details a zaškrtnút’ pri build step jom.exe
možnost’ install_unity

Fig. 1.30: QtC build project

20. Skontrolovat’ nastavenie build config – unity

21. Stačit’ Build (kladivko vl’avo dole)

22. Po úspešnom zbuildovaní vybrat’ Projects > Build & Run > Run, v časti Run pridat’ Add > Custom Executable
a nastavit’:

(a) executable: %3DSoftViz%/_install/bin/3DSoftviz.exe

(b) working directory: %3DSoftViz%/_install/bin/

23. Skontrolovat’ nastavenie run config – zadaná cesta

24. Spustit’ program pomocou zeleného tlačidla Run
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Fig. 1.31: QtC build config

Fig. 1.32: QtC run project
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Fig. 1.33: QtC run config

1.2.2 Rozšírenie 3DSoftviz o Kinect

1. Nainštalovat’ Kinect for Windows

2. Skontrolovat’ v RapidEE či sa vytvorila premenná %KINECTSDK10_DIR%

Fig. 1.34: KINECTSDK10_DIR premenná

3. Nainštalovat’ OpenNI2 (OpenNI-Windows-x86-2.2.msi)

• x86! – inak sa môžu vyskytnút’ problémy s linkovaním

4. Skontrolovat’ v RapidEE či sa vytvorili premenné:

(a) %OPENNI2_INCLUDE%

(b) %OPENNI2_LIB%

(c) %OPENNI2_REDIST%

(d) %OPENNI2_ROOT%

Fig. 1.35: NITE2 premenné
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5. Nainštalovat’ NiTE2 (NiTE-Windows-x86-2.2.msi)

• x86! – inak sa môžu vyskytnút’ problémy s linkovaním

6. Skontrolovat’ v RapidEE či sa vytvorili premenné:

(a) %NITE2_INCLUDE%

(b) %NITE2_LIB%

(c) %NITE2_REDIST%

(d) %NITE2_ROOT%

Fig. 1.36: OPENNI2 premenné

7. Pridat’ do premennej CMAKE_INCLUDE_PATH:

(a) %OPENNI2_INCLUDE%

(b) %NITE2_INCLUDE%

Fig. 1.37: OPENNI2 premenné

8. Pridat’ do premennej CMAKE_LIBRARY_PATH:

(a) %OPENNI2_ROOT%/Driver

(b) %OPENNI2_REDIST%

(c) %OPENNI2_REDIST%/OpenNI2/Drivers

(d) %OPENNI2_LIB%

(e) %NITE2_ROOT%/Samples/Bin/OpenNI2/Drivers

(f) %NITE2_LIB%

9. Pridat’ do premennej PATH:

(a) %OPENNI2_REDIST%/OpenNI2/Drivers
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Fig. 1.38: OPENNI2 premenné

(b) %OPENNI2_REDIST%

(c) %NITE2_REDIST%

(d) %NITE2_ROOT%/Samples/Bin

Fig. 1.39: OPENNI2 premenné

10. Spustit’ CMake a skontrolovat’ vo výpise:

(a) OpenNI2 FOUND

(b) NITE2 FOUND

(c) KINECTSDK FOUND

1.2.3 Nastavenie debuggera v QtCreator

1. Nainštalovat’ WinDbg

2. Skontrolovat’ v QtCreator Tools > Options > Build & Run > záložka Debuggers či sú autodetected
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Fig. 1.40: QtC debugger nastavenia

3. Pridat’ do QtCreator Tools > Options > Build & Run > záložka Kits pre vytvorený profil položku Debugger
(x86)

4. Spustit’ CMake (-DCMAKE_BUILD_TYPE=Debug)

5. Zvolit’ možnost’ Debug (vl’avo dole medzi Run a Build)

1.3 Návod pre Linux

1. Nainštalovat’ Synaptic Package Manager
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2. Nainštalovat’ prostredníctvom Synaptic nasledujúce programy

• Git - git

• OpenSceneGraph - libopenscenegraph-dev

• Qt4 - libqt4-dev

• QtCreator - qtcreator

• Boost - libboost-all-dev

• Lua - liblua5.1-0-dev

• OpenCV - libopencv-dev

• FreeGlut3

– freeglut3

– freeglut3-dev

• CMake 3.5.0

– inštalovat’ zo source files, nie Synaptic

Note: Názvy knižníc sú ukázané pre Ubuntu

3. Klonovat’ cez Git projekt 3dsoftviz (AlphaReach klonuje z repozitára Cimox)

• git clone ** url repozitára **

• git submodule update –init –recursive

4. Zbuildovanie projektu
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• Otvorit’ QtCreator

• File >> Open file or project >> Otvorit’ CmakeList.txt v zložke 3dsoftviz

• Vytvorit’ projekt

– Ak úspešne (dá sa kliknút’ na FINISH) >> Kliknút’ FINISH

– Ak neúspešne – Nájst’ chybu vo výpise

5. Nastavit’ build v QtCreator-i

Projects >> Build and Run >> Build Build Settings >> Add >> Clone Selected >> pomenovat’ “unity”
- automaticky prepne na unity build mode Build Steps >> Details >> zaškrtnút’ install_unity

Nastavenie počtu jadier na buildovanie projektu... Details >> Additional arguments “-jN”, kde N
reprezentuje počet VIRTUÁLNYCH jadier

6. Pridanie Kinectu do projectu

• Nainštalovat’ NiTE – pridat’ systémové premenné

• Nainštalovat’ OpenNI – pridat’ systémové premenné

Note: Pre použitie je nutný Kinect for XBOX

Attention: Na OSX, ak je found OpenNI2 a NiTE2, aplikacia crashne pri spustani s chybovou hlaskou:
• not found libNiTE2.dylib
• not found libOpenNI2.dylib

Treba tieto kniznice skopirovat z ich domovskych priecinkov (z lib alebo redist).

7. Inštalácia drivera pre 3dmyš

• Nainštalovat’ Motif3 pomocou Synaptic Package Manager

• Pre uistenie, že 3dmyš funguje, skúsit’ xapp aplikáciu z drivera

– Pre spustenie drivera (ktory musi bezat pre pouzivanie mysi) spustite prikaz

sudo /etc/3DxWare/daemon/3dxsrv -d usb

– Pre podrobnejsie instrukcie ohladne instalacie a pouzivania drivera otvorit navod prilozeny v suboroch
oficialneho drivera pre Linux “InstallationInstructions_Linux.txt“
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1.4 Používatel’ská príručka pre 3D Softviz

Okno s aplikáciou je rozdelené na tri základné časti:

• menu

– File – načítanie grafu zo súboru, z databázy, uloženie grafu, uloženie layoutu, ukončenie aplikácie

– Settings – nastavenia aplikácie; konfiguračný súbor používa bodkovú notáciu, ktorá umožňuje identifiko-
vat’ význam konfiguračnej premennej

– Help

– Test - pušt’a základné grafy pre rýchle testovanie (100-uzlový, 500-uzlový, Veolia, Lua-graph)

• hlavné okno - zobrazuje graf a umožňuje s ním používatel’ovi interagovat’

• ovládací panel – nástroje pre prácu s grafom

1.4.1 Ovládacie prvky

Ovládanie kamery:

• Vyber prvkov grafu - l’avé tlačidlo myši + pohyb myšou

• Otáčanie kamery okolo grafu - pravé tlačidlo myši + pohyb myšou

• Ovládanie priblíženia obrazovky - koliesko na myši

• Ovládanie pomocou klávesnici:

– Hore - PgUp

– Dole - PgDn

– Vl’avo - šípka vl’avo

– Vpravo - šípka vpravo

– Dopredu - šípka hore

– Dozadu - šípka dole

Inicializácia automatického pohybu začne po stlačení kláves Alt + Shift a kliknutím myši na zvolenú hranu, či uzol.
V závislosti od nastavenia aplikácie sú pred inicializovaním pohybu ešte automaticky vybrané body záujmu. Pokial’
je automatický výber uzlov vypnutý, body záujmu je možné zvolit’ manuálne myšou alebo stlačením klávesy Q (pre
náhodný výber uzlov alebo pre výber uzlov pomocou metrík). Automatické použitie metrík je možné vypnút’ v
nastavení aplikácie pomocou parametra „Viewer.PickHandler.SelectInterestPoints“ nastaveného na hodnotu 1.

Iné ovládacie prvky:

• Kláves “T” – skrytie všetkých ovládacích prvkov

• Kláves “S” - štatistiky vykresl’ovania

• Kláves “Shift” - pridávanie d’alších objektov do výberu

• Kláves “Ctrl” - odstránenie objektov z výberu
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1.4.2 Záložka GRAPH

- manipulácia s prvkami grafu (no-select mód), pohyb vybraných uzlov v priestore

- výber jedného prvku grafu (single-select mód)

Umožňuje sústredenie sa na práve jeden objekt – môže to byt’ hrana aj uzol.

- výber viacerých prvkov grafu (multi-select mód)

Umožňuje vybrat’ v trojrozmernom zobrazení viacero objektov naraz.

- typ výberu: všetko, iba uzly, iba hrany, klastre

- centrovanie pohl’adu vzhl’adom na vybraný prvok grafu

V prípade, že nie je označený žiadny element, kamera bude vycentrovaná na t’ažisko grafu

- pridanie meta uzla do grafu

- odstránenie vybraných meta uzlov z grafu
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- ukotvenie vybraných uzlov na aktuálnej pozícii, t. j. nebudú sa pohybovat’ v závislosti od pôsobenia síl
ostatných uzlov

- uvol’nenie ukotvených uzlov

- pridanie hrany medzi dvomi vybranými uzlami

Umožňuje pridat’ hranu medzi dvoma vybranými uzlami, kde ešte nie je hrana, inak končí akcia chybovou hláškou.
Ideálne je čiernou šípkou vybrat’ jeden uzol a bielou šípkou ho nastavit’ na také miesto, kde sa ho dá spojit’ s druhým
uzlom - je potrebné mat’ nastavenie Node v takomto prípade spolu s Multi-select mode.

- pridanie uzla do stredu pohl’adu

- odstránenie vybraných elementov (uzly alebo hrany)

Ak sa rozhodneme pre zmazanie hrany, uzly prepojené s touto hranou v grafe zostávajú.

, - zafarbenie zvolených uzlov a hrán farbou vybranou z palety
nad tlačidlom

- aplikovanie textového označenia na vybrané uzly podl’a textu z pol’a nad tlačidlom
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- zapnutie/vypnutie zobrazovania popisov uzlov a hrán

, - spustenie/zastavenie rozmiestňovania (animovania) uzlov grafu

- zmena odpudivých síl pôsobiacich medzi uzlami

- výber vizuálnej reprezentácie uzla (square, sphere) a výber vizuálnej reprezentá-
cie hrany (quad, cylinder, line)

1.4.3 Záložka CONSTRAINTS

– aplikovanie priestorového ohraničenia: povrch gule

- aplikovanie priestorového ohraničenia: obsah gule

- aplikovanie priestorového ohraničenia: rovina

- aplikovanie priestorového ohraničenia: zjednotenie gule a roviny

Zjednotenie gule a roviny je vhodné pre zobrazenie grafov s hustým stredom, alebo na vel’ké grafy.
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- aplikovanie priestorového ohraničenia: kružnica

Aplikovanie obmedzenia na kružnicu na uzly v celom grafe je vhodné pre vel’mi riedke grafy alebo na grafy s pravidel-
nou štruktúrou. Pri hustých grafoch sa hrany medzi uzlami prekrývajú

- aplikovanie priestorového ohraničenia: kužel’

Obmedzenie na kužel’ je vhodným riešením v prípadoch, kedy má jeden uzol výrazne vyšší počet hrán ako ostatné
uzly.

- aplikovanie priestorového ohraničenia: kužel’ový strom

Po aplikácií sa uzly rozdelia do skupín podl’a spoločného rodiča. Na tieto skupiny sa aplikujú obmedzenia na kužel’,
ktoré sú následne obmedzené na roviny v závislosti od hĺbky uzlov v strome. Kužel’ový strom sa aplikuje automaticky
na celý graf na základe používatel’om vybraného koreňového uzla. Jedine v prípade, že graf nie je spojitý, tak sa
aplikuje iba na komponent, ktorý obsahuje koreňový uzol.

- odstránenie vybraných priestorových ohraničení

- aplikovanie priestorového ohraničenia: povrch valca

Vloží do scény tzv. bod záujmu, od ktorého sú uzly zobrazovaného grafu odtláčané do tvaru valca. Polomer valca sa
dá nastavit’ pomocou číselníka.

- aplikovanie priestorového ohraničenia: povrch kužel’a

Vloží do scény tzv. bod záujmu, od ktorého sú uzly zobrazovaného grafu odtláčané do tvaru kužel’a. Polomer kužel’a
sa dá nastavit’ pomocou číselníka. Vel’kost’ kužel’a sa nastavuje automaticky podl’a toho, kam sa používatel’ prostred-
níctvom kamery pozerá.
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- aplikovanie radiálneho rozmiestnenia na označené uzly

Odporúča sa používat’ pri stromovom type grafu. Použitie rozmiestnenia na označené uzly dáva používatel’ovi nové
možnosti ako zväčšenie priestoru označením uzlom, alebo manuálne zhlukovanie uzlov.

- výber módu vykreslenia radiálneho rozmiestnenia (drôtený, plný)

- nastavenie módu 2D/3D radiálneho rozmiestnenia

1. nastavenie vel’kosti rozmiestnenia

2. nastavenie priehl’adnosti rozmiestnenia

3. nastavenie počtu zobrazených gúl’

4. nastavenie faktora zosilnenia odpudivých síl v radiálnom rozmiestnení pre uzly, ktoré nie sú na rovnakej vrstve

5. nastavenie faktora zosilnenia odpudivých síl v radiálnom rozmiestnení pre uzly, ktoré sú na rovnakej vrstve

Vel’kost’ radiálneho zobrazenia sa dá nastavit’ v rozmedzí 0 – 300, parameter priesvitnosti 0 - 100 %, vel’kost’ faktora
zosilnenia odpudivých síl sa nastavuje medzi hodnotami 1 - 5000.

- prepínač medzi normálnou a vertigo kamerou

Tento mód kamery je vhodné použit’ vtedy, ked’ chce používatel’ menit’ dva rôzne pohl’ady na graf: lokálny pohl’ad,
pri ktorom môže používatel’ s väčšou presnost’ou skúmat’ jednotlivé uzly a vzt’ahy medzi nimi a globálny pohl’ad, pri
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ktorom môže používatel’ skúmat’ vzt’ahy medzi uzlami a rozloženie uzlov v daných hĺbkach kostry grafu v globálnom
kontexte.

- zvýšenie vzájomnej vzdialenosti medzi rovinami

- zníženie vzájomnej vzdialenosti medzi rovinami

- pridanie dvoch paralelných rovín

Obmedzenie na roviny sa aplikuje pri grafoch s minimálnou maximálnou hĺbkou kostry grafu hodnoty 2. Koreňový
uzol v kostre grafu určí program - vyberie uzol s najväčším počtom hrán. Pri zrušení obmedzenia sa uzly „odpoja“ od
roviny.

- odobranie dvoch paralelných rovín

- zmena násobiča odpudivých síl medzi uzlami

Násobič odpudivých síl medzi uzlami je na začiatku nastavený na 1 kvôli prvému pridaniu dvoch rovín do priestoru -
nechceme, aby sa hned’ zväčšili odpudivé sily.

- vypnutie všetkých predchádzajúcich obmedzení

1.4.4 Záložka CLUSTERING

- zlúčenie vybraných uzlov
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Umožňuje zlúčit’ vybrané uzly do jedného spoločného uzla. Takýto uzol sa bude v pokračovaní zobrazovat’ modrou
farbou.

- zrušenie zlúčenia vybraných uzlov

- definovanie algoritmu, ktorým sa bude zhlukovat’ graf (adjacency, leafs, neighbours)

- nastavenie počtu rekurzií pre vybraný algoritmus

- spustenie zhlukovania nad aktívnym grafom

Ak zhlukovanie trvá viac ako 1 sekundu, objaví sa indikátor postupu.

1. spustenie algoritmu na zväzovanie hrán

2. pozastavenie algoritmu na zväzovanie hrán

3. úplne zastavenie algoritmu na zväzovanie hrán a zobrazenie pôvodného grafu

4. vstupné pole na zadanie konštanty, určujúcej silu akou sú hrany k sebe počas zväzovacieho algoritmu prit’aho-
vané

Po použití funkcie zhlukovania, sa odkryjú nasledujúce možnosti:

auto - automatická priehl’adnost’ - mení sa na základe vzdialenosti zhlukov od kamery
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selected - priehl’adnost’ označeného zhluku – pomocou posuvníka(nižšie) sa mení priehl’adnost’ len označených zh-
lukov

- posúvaním upravíme priehl’adnost’ označených zhlukov

- posúvaním sa mení prahová hodnota, pri ktorej sa menia tvary zhlukov

Spodné číslo udáva, kol’ko uzlov obsahuje daný zhluk (v tomto prípade 8).

Pri označení konkrétneho zhluku sa odkryjú nasledujúce možnosti:

- kliknutím zmeníme označený zhluk na obmedzovač

Obmedzuje pozície uzlov tak, aby z neho nevyšli von. Ked’ obmedzovač posunieme dostatočne d’aleko, t.j. mimo
pôvodnej pozície uzlov, uzly sa začnú lepit’ na jeho stenu a posúvat’ spolu s ním. Ignoruje prít’ažlivé a odpudivé
sily medzi ním a ostatnými uzlami grafu (posunutie zhluku bez obmedzovača spôsobí posun celého grafu za týmto
zhlukom). Obmedzovač začína svoje pôsobenie ako kocka, je možné zmenit’ jeho tvar nat’ahovaním a stlačením.

- znovurozmiestnenie uzlov v priestore po tom, ako sa nalepia na hranu obmedzovača

- upravenie odpudivej sily medzi uzlami v označenom zhluku

Čím je hodnota väčšia, tým budú uzly d’alej od seba.

Ďalšie funkcie obmedzovača:
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Ak na zhluk zaregistrujeme obmedzovač, môžeme s ním jednoducho pohybovat’ a menit’ jeho tvar pomocou
klávesových skratiek a myši:

• Pohyb – metóda t’ahaj a pust’ ( drag & drop )

• Zmena vel’kosti – držíme Ctrl a točíme kolieskom myši

• Zmena tvaru

– na osy x – držíme X a Ctrl a točíme kolieskom myši

– na osy y – držíme Y a Ctrl a točíme kolieskom myši

– na osy z – držíme Z a Ctrl a točíme kolieskom myši

1.4.5 Záložka CONNECTIONS

- napísanie mena, pod ktorým bude používatel’ vystupovat’ v kolaborácii

- spustenie/zastavenie servera

- napísanie IP adresy servera

- pripojenie(odpojenie) ku(od) kolaborácii

- zoznam používatel’ov (zoradený abecedne), v ktorom je možné jedného vybrat’ a použit’
nasledujúce funkcie:
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- po výbere si môžeme zvolit’ jednu funkciu z dvojice: Spy (špehovat’) a Center (centrovat’).

Po aktivovaní funkcie Spy získa používatel’ pohl’ad iného používatel’a, ktorý je priebežne aktualizovaný – znamená
to, že pohybom sledovaného používatel’a sa aktualizuje aj pohl’ad sledujúceho. Po aktivácii Center nasmeruje pohl’ad
používatel’a tak, aby v jeho strede bol iný používatel’. Pri centrovaní platí to isté, čo pri špehovaní – teda pri aktual-
izácii polohy centrovaného používatel’a sa natáča aj pohl’ad centrujúceho používatel’a. Po označení políčka Shout sa
ostatným používatel’om v scéne zobrazí pri vašom mene ikona znázorňujúca, že sa pokúšate upútat’ pozornost’.

- nastavenie vel’kosti avatarov v scéne

Avatar je kužel’, ktorého kruhová podstava znázorňuje smer, ktorým sa používatel’ pozerá.

1.4.6 Záložka EVOLUTION

- Po rozkliknutí tabu Evolution (1) sa zobrazia možnosti evolúcie

2. Lifespan - možnost’ ponechania vymazaných uzlov vo vizualizácii. Prednastavená hodnota 0 znamená, že vy-
mazané uzly sa automaticky vymažú z grafu. V prípade hodnoty väčšej ako 0 vymazané uzly v grafe zotrvávajú
o verzie dlhšie podl’a nastavenej hodnoty

3. Change commits - prepínač spracovania Git repozitáru. Ak je zaškrtnutý, inicializuje sa spracovanie na úroveň
grafu volaní. V opačnom prípade - na úroveň histórie Git repozitáru

4. Kombo box s výberom vizualizácie - prepínanie sa medzi jednotlivými možnost’ami vizualizácie grafu volaní

• LuaStat - vizualizácia softvérových metrík pomocou analýzy Lua zdrojového kódu

• Difference - pohl’ad na zmeny, ktorými softvér prešiel pri prechode na novú verziu
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• Changes - aktivovanie filtrovania nad práve aktívnou vizualizáciou

5. Kombo box s výberom filtra - výber vhodnej skupiny filtra

• Prednastavená možnost’ All - všetky prvky grafu sú zobrazené

• Authors - filtrovanie podl’a autorov zmien v softvéri

• Structure - filtrovanie podl’a štruktúry

6. Kombo box zoznamu možností - moznosti zavisia od vybraneho filtru

• zoznam autorov s možnost’ou zobrazenia zmien všetkých autorov - All

• štruktúra - Files (zobrazí v grafe volaní len uzly reprezentujúce adresáre a súbory), Local Functions
(zobrazí rozšírenú možnost’ Files spolu s uzlami lokálnych funkcií), Global Functions (zobrazia sa
uzly možnosti Local Functions spolu s uzlami globálnych funkcií) a Modules (zobrazí všetky štruk-
túry, ktoré sa v grafe nachádzajú)

- panel ovládania evolúcie

1. Prechod na predchádzajúcu verziu - možnost’, kedy sa stav grafu vráti o jednu verziu dozadu

2. Prechod na nasledujúcu verziu - možnost’, kedy sa stav grafu posunie o jednu verziu dopredu

3. Tlačidlo informácií o verzii - zobrazí informácie o aktuálne zobrazenej verzii. Medzi zobrazené informácie patrí
identifikátor, autor a dátum commitu spolu so zoznamom súborov, ktoré boli zmenené

4. Sputenie/zastavenie animácie - aktivovanie/zastavenie automatického prechodu na novú verziu

5. Posuvník - presun na konkrétnu verziu pomocou skokového prechodu medzi verziami

6. Indikátor verzie - poskytuje informáciu o aktuálne zobrazenej verzii

7. Spomalenie animácie - regulovanie rýchlosti animácie

8. Zrýchlenie animácie - regulovanie rýchlosti animácie

1.4.7 Záložka MORE FEATURES

- zapnutie 3D myšky (musí byt’ aktivovaný driver)

- ak je zaškrtnuté, kamera nasmerovaná na graf sa pohybuje na základe pohybu tváre, značky
alebo rúk, inak sa na základe týchto akcií rotuje samotný graf
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- povol’uje použitie kamery

- otvorenie okna pre prácu s kamerou

- otvorenie okna pre prácu s hlasovým ovládaním

Note: Speech je momentálne vylúčený z projektu

- zapnutie ovládania pomocou Leap Senzor–u

Okno pre prácu s kamerou

- prispôsobenie l’avej strany okna pre ovládanie funkcionality rozpoznávania tvare
(pri zapínaní treba zaškrtnút’ Camera rotation a Camera enabled)

- zvolenie kamerového zariadenia a následným potvrdením objavenie záberu z kamery

Ukončit’ túto akciu je možné tlačidlom „StopFaceRec“ (ak používatel’ zatvoril okno, môže ho vrátit’ na grafický
interface opätovným kliknutím na „StartCamera“ a potom pozastavit’ detekciu). V prípade detegovanej tváre (detekcia
je reprezentovaná zeleným obdĺžnikom) sa kamera alebo graf pohybuje vd’aka pohybu tváre.
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- okno pre
výber snímacieho zariadenia

- prispôsobenie l’avej strany okna pre ovládanie funkcionality rozpoznávania značky

- zvolenie kamerového zariadenia a následným potvrdením objavenie záberu z kamery
určenej pre rozpoznávanie značky a graf sa začne otáčat’ a pohybovat’ so značkou

- nastavenie aktuálne snímanie ako pozadie pre graf

Je potrebné zmenit’ parameter „Viewer.SkyBox.Noise“ v konfiguračnom súbore na hodnotu 2 alebo 3 (odporúčané je
3).
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- prepínanie medzi pohybom podl’a značky ako keby sa kamera pozerala na používatel’a a
naopak

- zapnutie korekcie

- nastavenie korekčných parametrov

Podl’a predvolených nastavení sa značka pohybuje tak, ako keby sa kamera pozerala vo vodorovnom smere. Ak by sa
pozerala napr. na stôl pod miernym sklonom dole, graf by sa pri posúvaní značky po stole neposúval korektne. Preto je
možné nastavit’ korekčné parametre. Najskôr je potrebné nastavit’ značku do polohy, kedy je detegovaná na spodnom
okraji a následne stačit’ toto tlačidlo. Po nastavení sa aktivuje opcia „Correction“ (uvedené vyššie), ktorou je možné
zapnút’ korekciu.

- zmena spôsobu použitia značky v prípade, že používatel’ má k dispozícii len jednu značku

- vypnutie/zapnutie zobrazenia videa

Toto prepínanie a vypnutie zobrazenia video má vplyv len na zobrazenie v rámci tohto ovládacieho okna „Face Recog-
nition“ and „Marker Detection“ a neovplyvňuje to ani vol’bu kamery pre video pozadie.
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- Interakcia s vizualizáciou v obohatenej realite

• Možnost’ Custom light, vyznačená modrou, ktorá slúži na prepínanie vlastného a základného zdroja svetla

• Možnost’ Shadow, vyznačená žltou, ktorá slúži na zapínanie a vypínanie generovania tieňov

• Možnost’ Base, vyznačená červenou, ktorá slúži na zobrazenie a skrytie základne

• Možnost’ Axes, vyznačená ružovou, ktorá slúži na zobrazenie a skrytie pomocných osí

• Tlačidlo Center graph, vyznačené svetlo modrou, ktoré slúži na umietnetie grafu nad stred základne

Okno pre prácu s kinectom a arucom

- zapnutie detekcie

- zachytenie kádra s následnou možnost’ou dat’ ho na pozadie

- zapnutie rozpoznávania značiek

- prepínanie medzi detekovaním ruky pre manipuláciu grafu alebo kamery v podobe rotova-
nia a medzi detekovaním ruky pre funkciu “klik” (pohyb ruky do hĺbky, nie vertikálne alebo horizontálne)
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- vypne možnost’ približovania

- nastavenie práce s arucom

- zobrazenie okna projekčného zobrazenia

- v projekcnom zobrazeni - Projector - spinboxy na zmenu parametrov projektora
(odhora) - zorné pole, pozícia (súradnice x, y, z), smer projekcie(súradnice x, y, z)

- v projekcnom zobrazeni - Viewer - spinboxy na zmenu parametrov pozorovatel’a
(odhora) - zorné pole, pozícia (súradnice x, y, z), smer projekcie (súradnice x, y, z)
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- v projekcnom zobrazeni - Graph - spinboxy na zmenu parametrov grafu (odhora)
- pozícia (súradnice x, y, z), polomer, checkbox Place graph na potvrdenie použitia parametrov grafu (štandartne
označený)

- potvrdenie zadaných parametrov scény

Hlasové príkazy pre Speech

• select all nodes - vybratie všetkých uzlov

• select left side - vybratie uzlov na l’avej strany

• select right side - vybratie uzlov na pravej strany

• clear screen - zrušenie vybratia uzlov

• sphere - sformovanie gule pre vybrané uzly

• unset restrictions - návrat k pôvodnému stavu - zrušenie akcie “sphere”

1.4.8 Hlavné okno

- filtrovanie hrán

- filtrovanie uzlov

Príklady príkazov:

• “params.type like ’file’ or params.type like ’directory’”

• “params.name like ’init%.lua’ and params.type like ’function’”

• “params.type like ’function’”
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Filter je navrhnutý pre grafovú vizualizáciu softvéru s využitím softvérových metrík jazyka Lua a je vyhodnotený po
stlačení klávesu „Enter“.

- zobrazí dialóg pre výber súborov a po vybratí vykreslí do pol’a pod tlačidlom graf
volaní funkcií týchto súborov

Pri označení práve jedného vrcholu v poli sa zobrazí stromová štruktúra informácií o tomto vrchole.

- prepínanie medzi zobrazovaním jedného prehliadača pre každý uzol a
zobrazovaním jedného prehliadača pre všetky vyznačené uzly

1.4.9 Git repozitár

1. Settings / Options - zobrazenie dialógového okna s konfiguráciou

2. Možnost’ Git - zobrazia sa možnosti konfigurácie spracovania Git repozitáru

3. Možnosti konfigurácie spracovania Git repozitáru

• vyčlenenie adresárov (ExcludeDirectories) - l’ubovol’ný počet názvov adresárov oddelených znakom
”,”. Pre zadanú hodnotu sa pri spracovaní Git repozitáru odignorujú všetky súbory, ktoré vo svojej
relatívnej ceste obsahujú adresár spec.

• ExtensionFilter - funguje obrátene, pričom ponecháva len tie súbory, ktorých koncovka súboru sa
zhoduje s jednou zo zadaných hodnôt. Hodnota taktiež môže obsahovat’ viacero koncoviek súborov,
pričom musia byt’ oddelené znakom ”,”
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3dSoftViz Documentation, Release v0.1

1.5 Používatel’ská príručka pre Vuzix a Leap

1.5.1 Stereoskopické 3D s Vuzix okuliarmi

Okuliare

Ako prvé je potrebné pripojit’ Vuzix okuliare k počítaču (HDMI a 2x USB)

Okuliare by mali byt’ rozpoznané ako zobrazovacie zariadenie, pre ktoré nastavte duplikáciu obrazu z monitora, na
ktorom beží 3Dsoftviz.

Nakoniec pomocou ovládacieho zariadenia vyvolajte menu a nastavte režim zobrazovania obrazu na side-by-side 3D
alebo top-bottom 3D, poprípade upravte aj jas a kontrast obrazu.

(menu sa zobrazí len priamo na displejoch okuliarov)

3Dsoftviz

Pre správne zobrazenie je potrebné nastavit’ 3Dsoftviz do režimu plnej obrazovky stlačením klávesy L a skryt’ panel
s nástrojmi stlačením klávesy T

Následne je možné pomocou klávesy G prepínat’ medzi režimami:

• normálne zobrazenie

• top-bottom 3D zobrazenie

• side-by-side 3D zobrazenie

Vyberte zobrazenie korešpondujúce s nastavením okuliarov.

Klávesami H a J je možné upravovat’ nastavenie vzdialenosti očí, ktorá mení posun medzi obrazmi ktorým sa dosahuje
3D efekt. Úprava je po 0.01m a aktuálna hodnota sa zobrazuje v konzole.
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1.5.2 Ovládanie rukami s Leap senzorom

Leap:

Ako prvé je potrebné pripojit’ Leap senzor k počítaču (1x USB). Ďalej je potrebné nainštalovat’ oficiálny softvér k
Leap senzoru z oficiálnej stránky.

3Dsoftviz:

V l’avej lište s nástrojmi je v karte More features možnost’ Start Leap, po stlačení ktorej začne snímanie rúk nad
senzorom.

Podporované je nasledovné ovládanie:

• L’avá ruka s vystretými prstami – pohyb kamery dopredu

• L’avá ruka so skrčenými prstami – zastavenie pohybu kamery

• Pravá ruka s vystretými prstami – kamera sa otáča podl’a naklonenia dlane

Snímanie je možné zastavit’ opätovným stlačením rovnakého tlačidla ktoré ma počas snímania text Stop Leap.
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